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Skills covered in this tutorial include:

e Obtaining excel data from the American Fact Finder on Census.Gov
e Obtaining Geography Data from census.gov

e Cleaning Excel Data for Joins

e Joining Excel Data in ArcMap

In this tutorial, we will be obtaining information about housing tenure at the Census Tract level from the

2010 Census for a single county using American Factfinder. You can then use asimilar process to download

any other Census 2010, American Community Survey, or Census 2000 data for other geography levels
and/or for whole states or multiple counties. You have many, many options in American Factfinder — this

shows one possible path.

Obtaining Data from American FactFinder (AFF)

1. Data management is critical when dealing with the multiple tables of the Census. Before beginning

this tutorial:
a. Create a Census 2010 folder in your personal workspace
b. Create two subfolders: AFF Data and Census Geography

2. Go to the US Census web site — http://census.gov

3. Click on the Data tab = Data Tools & Apps = select American FactFinder. This is the web interface to

access census excel/tabular data.


http://census.gov/
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Topics Geography  Library Data Surveys/Programs  Mewsroom  About Us
Population, Economy Maps, Products Infographics, Publications Tools, Developers Respond, Survey Data News, Blogs Our Research

Latest Information Data Tools & Apps v Developers Mobile Apps

American FactFinder Interactive Population Map
Census Business Builder: My Congressional District
Small Business Edition Population Clock

Latest Information Census Explorer State & County QuickFacts
Easy Stats

Find information using interactive applications to get
statistics from multiple surveys.

4. Click on Advanced Search and select Show Me All.
Community Facts
Guided Search

W Advanced Search

Search all data in American FactFinder, with access to
all geographic types and datasets

SHOWMEALL

Download Center

5. Click on Topics in the left column and expand Dataset.

Your Selections

Select Topics

“four Selections' iz empty

load search | save search Select Topics to add to "Your Selections' )

+ People

4+ Housing
Search using the options below: + Business and Industry
Topics + Governments
‘age, income, year, datazet, ) +| Year

+ Product Type

Program

I = Dataset I
2ME Populstion Estimates (5]
2015 ACS Soyear estimates (2,203)
2015 ACE 1 -year estimates (27007
2015 ACS 1-year Supplemental Extimates (600
2015 Annual Survey of Manufactures (100
2015 Annual Survey of Public Employment & Payroll (E]
2015 Population Estimates (51)
2015 Annual Survey of Public Pensions (2
2015 Annual Survey of State Government Tax Collections (4]
2014 ACS S-yvear estimates (2,259)
2014 ACS 1 -year estimates (2 5907 -

Geographies ’
[=ztatez, courties, places, ...]

Race and Ethnic Groups ’
[race, ancestry, tribe)

Industry Codes ’
[MAICS industey, (.0

EEQ Occupation Codes ’
[executives, analysts, ..

Hote: The Race & Ethnicity topic is available under the Race and
Ethnic Groups hutton on the left.

| Include archived products in your search 0
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6.

7.

8.
9.

10.

Scroll down to click on 2010 SF1 100% Data — this will send this criteria to your Selection box in the upper

left of the site:

g v gy
Search using the options below: Select Topics to add to "Your Selections O

< EEQ Tabulation 2008-2010 (S-year ACS data) (113) -~
(age, income, year, dataset, ...) 2010 SF1 100% Data (771)
2010 SF2 100% Data (276)

Topics

Scroll up in the Topics list and click on Housing. Then, under Occupancy Characteristic, click on
Owner/Renter (Tenure in Occupied Units).

2010 SF1 100% Data

clear all selections and

i s Select Topics to add to "Your Selections’

load search | save search
+ People

| - Housing |
+ Basic Count/Estimate
- Occupancy Characteristic
Age of Householder (60)
Hispanic or Latino Householder (20)
Household Size (145)
Household Type (166)
Occupancy and Vacancy Status (120)
|Owner/Renter (Tenure in Occupied Units) (141) |
Race/Ethnicity of Householder (179)

Search using the options below:

Topics

(age, income, year, dataset, ...) N

Geographies ’
(states, counties, places, ...)

Race and Ethnic Groups ’
(race, ancestry, tribe)

Close the Topics box in the top right of the box.
Click on Geographies on the left column — this brings up the Select Geographies overlay.

Fill out the box so that you are selecting Census Tracts for a specific state anda county in that state.
You can follow the example below if you want to select all census tracts in Suffolk County,
Massachusetts. Alternatively, you could pick a state and county of your choosing.

Dataset
2010 SF1 100% Data

Select Geographies
Housing:Occupancy Characteristic
Qwner/Renter (Tenure in Occupied List Name Address Map
Units) €
clear all selections and Select geographies to add to Your Selections )
start a new search
Ibad search | save search . Selectfrom: @® mostrequested geographic types (O all geographic types
Search using the options below: @ selectz geographic type:
. | ... ... Census Tract - 140 v
Topics b ‘

(age. income, year, dataset, ) @ selectastate;,

I Massachusettshy ¥ I

@ selectacount
Sufiolk v

Geographies -
(states, counties, places, ...)

(executives, analysts, ...}

Race and Ethnic Groups » ‘
(race, ancestry, tribe)
. Select one or more geographic areas and click Add to Your Selections:

Industry Codes » All Census Tracts within Sufiolk County, Massachusetts
(MNAICS industry, ...} - partially Urban Census Tracts within ffolk County, Massachusetls

Al fully/partially Rural Census Tracts within Suffolk County, Massachusetts

: Census Tract 1, Suffolk County, Massachusetts

EEOCecpation Coaes ’ ‘ Census Tract 2.01, Suffolk County, Massachusetts

Census Tract 2.02, Suffolk County, Massachusetts
Census Tract 3.01, Suffolk County, Massachusatts
Census Tract 3.02, Suffolk County, Massachusetts
Census Tract 4.01, Suffolk County, Massachusetts
Census Tract 4.02, Suffolk County, Massachusetts 7

ADD TO YOUR SELECTIONS
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11. Be sure to click on ADD TO YOUR SELECTIONS.

12. Close the Select Geographies overlay.

13. Be sure that the Your Selections box in the upper left corner contains what you want— the data set, the
general topic, and the census geography level for the specificlocation you want (all tracts, not just one
tract). If it does not say this, clear your selections and start over from Step 5 above.

Your Selections

Search using...
Dataszet:
2010 SF1100% Data €3

Housing:Occupancy Characteristic:
Owner/Renter (Tenure in Occupied
Units) €3

Census Tract

All Census Tracts within Suffalk
County, Massachusetts €

clear all selections and
start 3 new search

14. You should now have a list of available datasets about housing characteristics. Checkmark one of interest

and see what variables it contains by clicking onthe Information icon for that table. 6 For this exercise, we

highly recommend a table with just a few variables. In this exercise, we have used the H11 table for total
population in occupied housing.

15. After checking a table, click on Download ( [x) Download ) and follow the instructions. This creates a zip
file. Save it in your Census 2010 2AFF Data folder.

16. Navigate to your AFF folder. Right click on the zipped folder and select extract here or open with Power
Archiver and extract to AFF folder.

Preparing American Factfinder Data for Use in ArcMap

1. Double-click on both downloaded CSV files to open them:

A

Name Date modified Type Size

. aff_download_readme_ann Several files will be downloaded. The
|| DEC_10_SF1_H11 "with_ann" file contains the data while
@] DEC_10_SF1_H11_metadata the "metadata” file contains the
jﬁ_i DEC_10_SF1_H11_with_ann ¥ descriptions. Open both excel files.

Note: If you are opening the file from within Excel, you will need to set the option to look for all file types:

2. The “DEC_10...with_ann” file should look something like this.
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3.

Al - fe | GEQ.id
A B c D E F G H

1 GEO.id GEO.id2 GEO.displ DO0O1 Dooz2 D0oo3 Doo4

2 |Id 1d2 Geograph Total popt Owned wi Owned fr¢ Renter occupiec
3 |1400000U¢ 2.5E+10 Census Tri4225(r338: 794 231 3200
4 |1400000U¢ 2.5E+10 Census Tri3730(r338 828 262 2640
5 1400000U¢ 2.5E+10 Census Tri 3861 857 349 2655
6 |1400000UF 2.5E+10 CensusTr 2628 799 270 1559
7 |1400000UF 2.3E+10 CensusTri 2916 941 413 1562
8 |(1400000U: 2.5E+10 CensusTri 5672 851 281 4540
9 | 1400000UF 2.5E+10 CensusTri 3511 868 297 2346
10 | 1400000U¢  2.5E+10 CensusTri 3110 a47 154 2509
11 |1400000U¢ 2.5E+10 Census Tri 2211 444 81 1686
12 |1400000U¢ 2.5E+10 Census Tri 4915 682 187 4046
13 |1400000U¢  2.5E+10 CensusTri 3371 818 248 2305
14 | 1400000U%  2.3E+10 CensusTri 3974 264 107 3603
15 |1400000U¢ 2.5E+10 Census Tri 4397 474 150 3773
16 1400000U¢ 2.5E+10 CensusTri 2619 £l 25 2504
17 1400000U¢  2.53E+10 CensusTri 4734 a47 154 4193
18 1400000U¢ 2.5E+10 CensusTri 7869 907 316 6646
195 |1400000U¢ 2.5E+10 Census Tri 1601 11 6 1584
20 1400000U¢  2.5E+10 CensusTri 720 33 34 653
21 |1400000U%  2.3E+10 CensusTri 2914 493 168 2248
22 |1400000U¢  2.5E+10 Census Tri 5407 289 60 5058

Now look at the “DEC_10... _metadata” file. This file explains the column header codes inthe data file - it
should look something like what you see below. This is a very importantfile!!!

A B C D E
1 GEOQ.id Id
2 GEOQ.id2 Id2
3 GEO.displ Geography
4 |D001 Total population in occupied housing units:
5 |D0o2 Owned with a mortgage or a loan
6 D003 Owned free and clear
7

Doo4 Renter occupied

Typically the first data column (D001 here) is the Universe of things counted in this table. This table is
counting people in occupied housing units. If you wanted to show the % of the population that is in rented
housing units, you would divide D004 by D001 and multiply by 100. This process is called “normalizing”.

A few important steps left.

1.

ArcGIS does not like ANY extra characters in the column names. Delete all periods (.) and extra
characters (-) in all the column names/heading. The only acceptable character is underscores (_).

The Geo ID in the Census Tracts polygon attribute table to which you will be joiningthis data table is
in a text format. GEOID2 in this file must also be text for the join to work properly.

a) Click on the tab (B) above GEOID2 to highlight the entire column.
b) Click on the Excel Tab for Data

c) Click on Text to Columns:
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PAGE LAYOUT ' ORMULAE DATA REVIEW VIEW

| HOME IMSERT
N ||= [2] Connections & H Y N - E a 4
& & 2 2 Ee |=F & ®
rom - Frd rom Other Existing Refresh El Sort Filter _ Textto flash  Remove Data C
WNeb Sources~  Connections  All~- - T Advanced Columns |Fill  Duplicates Validation ~
ernal Data Connections Sort & Filter Data Tool
- )(1 GEOId2 Text to Columns

Split a single celumn of text into
4 y C D E rmultiple columns,
d |GEOId2 |GEOdisplaylabel D001 D002 _

—| Forexample, you can separate a
1d2 Geography Total populat Owned Wit cojumn of full names into separate

000U] 2.5E+10|Census Tract 1, Suffolk County, Massachusetts 4225(r33818) 79¢ first and last name columns.
000Uy 2.5E+10|Census Tract 2.01, Suffolk County, Massachusetts 3730(r33819) Bag | ) L

You can choose how to split it up:
000U 2.5E+10|Census Tract 2.02, Suffolk County, Massachusetts 3861 851 fixed width or split at each comma,
000U] 2.5E+10|Census Tract 3.01, Suffolk County, Massachusetts 2628 79¢ period, or other character.
000Uy 2.5E+10|Census Tract 3.02, Suffolk County, Massachusetts 2916 941

e Tell me more
000U] 2.5E+10|Census Tract 4.01, Suffolk County, Massachusetts 5672 851 — R
000U 2.5E+10|Census Tract 4.02, Suffolk County, Massachusetts 3511 368 297 2346
000U] 2.5E+10|Census Tract 5.02, Suffolk County, Massachusetts 3110 447 154 2509
000U] 2.5E+10|Census Tract 5.03, Suffolk County, Massachusetts 2211 444 31 1686
nn D ECAINICAnciie Trart E NA Cuiffall Cooondtr Maccackhnicate A0 [rie | 197 ANAR

d) Click Next to leave the first setting at Delimited.
e) Click Next to leave the second setting at Tab.

f) In Step 3, change the column data format to TEXT, and then hit Finish.
B[t

Convert Text to Columns Wizard - Step 3 of 3 -

-

This screen lets you select each column and set the Data Format.
Column data format
) General ) )

. ‘General' converts numeric values to numbers, date values to
dates, and all remaining values to text.

() Date:  |MDY

() Do notimport column (skip)

]
i

Destination: | $B§1

Data preview

3. Census.gov now includes the description of the column under the column heading in the excel sheet
(e.g. Under D001 it says Total Population). However, ArcMap does not like this extra row and the text
causes the software to read it as a “string” (e.g. text) instead of “double” (e.g. numbers). Therefore, it
is necessary to delete this row so that ArcMap realizes that this is a number field and not a text field.

4.

Vi M Jx || @
Calibri -|11 ~| A" &7 § - % » & c D E F G H
B I =O-A-¢ ¥ Do0t Doz D003 Dopa
2 |id [1d2 |Geography Total populat'Owned with Owned fre Renter occupied
"X cut D CensusTract 1, Suffolk County, Massachusetts 725 794 731 3200
Ey Copy 0 Census Tract 2.01, Suffolk County, Massachusetts 3730 828 262 2640
hD Pote Ot 0 Census Tract 2.02, Suffolk County, Massachusetts 3861 857 349 2655
o o 0 Census Tract 3.01, Suffolk County, Massachusetts 2628 799 270 1559
== 0 Census Tract 3.02, Suffolk County, Massachusetts 2916 941 413 1562
Paste Special... 0 Census Tract 4.01, Suffolk County, Massachusetts 5672 851 281 4540
Tnsert 0 Census Tract 4.02, Suffolk County, Massachusetts 3511 863 297 2346
0. Census Tract 5.02, Suffolk County, Massachusetts 3110 447 154 2509
0. Census Tract 5.03, Suffolk County, Massachusetts 2211 444 81 1686
Clear Contents g Census Tract 5.04, Suffolk County, Massachusetts 4915 682 187 4046

Optional Tip — Although you need to delete the 2" row of text, you can change the column headings

to the descriptions if it makes it easier (e.g. Change D001 to Tot_Pop). However, there can be no

spaces or periods and the heading needs to be under 9 characters. For excel sheets containing several
fields, it’s probably easier to refer tothe codes later rather than changing all the column headings.

To make things easier later, rename the worksheet to something comprehensible, e.g.,

Housing Tenure - the worksheet name will be the identifier in ArcCatalog.
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44 11400000U525025040100 IIIr25I:I'125I:I«’-II:I'II:I'I:I' Cens
145 11400000U525025040200 FZSDEEMDZDD Cens
Housing Tenure

5. Very important step — save your modified CSV file as an Excel Workbook (.xIsx) — giveit a
comprehensible name, e.g., 2010 Census H11_population by housing tenure.xlsx

Note: Your table may have columns, like DO01/Tot_Pop, where the data has text values in it (ex:
4225(r33818)). Since ArcMap uses the first eight rows to determine what the data type is for each
column (ex: string, float, double, integer, etc.), it is necessary to delete the information in parentheses
for it to be mappable as a number.

A B C ] E F G
1 |GECID GEOQID2 Geo_display Tot Pop Own_Loan Own_Free Renter
2 |1400000U525025000100 25025000100 Census Tract 1, suffolk County, Massachusetts 4225(r33818) 794 231 3200
3 1400000U525025000201 '25025000201 Census Tract 2.01, Suffolk County, Massachusetts 3730(r33819) 828 262 2640
4 1400000U525025000202 '25025000202 Census Tract 2.02, Suffolk County, Massachusetts 3861 357 343 2655
5 |1400000U525025000301 '25025000301 Census Tract 3.01, Suffolk County, Massachusetts 2628 799 270 1559
6 |1400000U525025000302 25025000302 Census Tract 3.02, Suffolk County, Massachusetts 2916 941 413 1562

6. Extra step for Alaska, Alabama, Arkansas, Arizona, California, Colorado, and Connecticut. (/gnore
this section if you are not working in these states)

Some states have FIPS codes that start with a zero, and because Excel removes thatleading zero, the table
won't join properly unless we put it back on. If you're working in Alaska, Alabama, Arkansas, Arizona,
California, Colorado, or Connecticut, you'll have to add that zero back on manually. To add the zero back on,
at the beginning of the table, under Column A, at Row2 type in: =concatenate(“0”,B2).

A2 - X« Jfr | =concaTENATE("0", 52|

A B C
1 |GEQID GEOID2 Geo_display
2 |TATENATE("0", B2) [25025000100 [Census Tract 1, Suffalk County, Massachusetts
4

1400000U525025000201 25025000201 Census Tract 2.01, Suffalk County, Massachusetts
1400000US25025000202 25025000202 Census Tract 2.02, suffalk County, Massachusetts

Hit Enter. If the result of that formula looks right (i.e. it has a leading zero), copy that cell’s formulato the
rest of the column.

You're almost done! To keep this compatible with the rest of the directions, copy all of the cells in this new
column, and right click on the GEQid2 column. Click the options below “Paste Special”, choose Values, and
your leading zeroes should be all set. Ensure your column is still named GeolD2.

Delete the column you added but be sure you still have the fixed GeolD2 column. Save thefile!

Final STEP: Save your file and EXIT out of Excel — you CANNOT have Excel open still when
you work with this data in ArcGIS!
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Obtaining GIS files from Census Geography

Now you need to download the geospatial data, in this scenario you will download “Census Tract polygons”.

1. Go tothe Census web site (http://census.gov) and click on Geography tab and then Maps & Data.

U.S. Department of Commerce | Blogs

CUnited States" | o Search

ensus

Geography  Library Data Surveys/Programs  Newsroom
Maps. Products Infographics, Publications Tools, Developers Respond, Survey Data News, Blogs

Latest Information Education
Interactive Maps Maps & Data Metropolitan & Micropolitan

Reference Research

2. Under Geographic Data, select TIGER Products. Then click on Tiger/Line Shapefiles in the TABLE as shown:

Geography

Reference Partnerships

Maps & Data

= Maps & Data Main Page

TIGER Products

M TIGER = Tepolegically Integrated Geographic Enceding and Referencing

aps

TIGER products are spatial extracts from the Census Bureau's MAF/TIGER database. containing features such as
rivers, as well as legal and statistical geegraphic areas. The Census Bureau offers several file types and an enline
application. Our products are:

+ TIGER/Line Shapefiles - New 2015 Shapefiles
« TIGER/Line Geodatabases

= Census Data Mapper

= Reference

= Thematic

= Maps Available for Purchase

« TIGER/Line with Selected Demographic and Economic Data

Data « Cartographic Boundary Shapefiles
= TIGER Products « KML - Cartographic Boundary Files
= Census Geocoder « TIGERweb

= Partnership Shapsfiles 25 Years and Counting
= Relationship Files « TIGER Story Map (Part 1)

= Gazefteer Files

« Happy 25th Anniversary, TIGER
TIGER Data and Product FAQs

= Block Assignment Files

= Mame Lookup Tables

= Tallies Which product should | use?
= LandView . Level of |Descrig

Maost mapping projects—-this is our  Shapefiles Boundaries, roads.  Full detail Extensi®
11 (== 8T,T most comprehensive dataset (.shp) and address (not

b FT0= i1 Designed for use with GIS database files information, water  generalized)
(gecgraphic information systems).  (.dbf) features, and more

3. Click on 2016 and expand Download tab. Then clickon Web Interface.


http://census.gov/
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20186 2015 2014 2013

2016 TIGER/Line Shapefil

All legal houndaries and names are

-~Download

« Web interface

« FTP site

rTechnical Decumentation
»File Availability
rUser Notes

4. Under Select a Layer Type choose Census Tracts then Submit.

Select a layer type

Census Tracts E [m
Geographic Areas -
American Indian Area Geography [ |Jivision
Blocks
Block Groups

Congressional Districts
Consolidated Cities

5. Select your State of interest and download the data set — it is compressed in a .zipfile.

6. Save the zip file into the Census Geography folder. Navigate to the folder and rightclick on the zipped file.
Select extract here or Extract files and select the geographyfolder.

Now you’re ready for mapping!
Joining the AFF table to your Census Tract polygons in ArcMap

1. Start a session of ArcMap with a blank map.

2. Add your Census Tracts geography data set to the map (e.g., t_l_2'016_25_tract.shp) from your H Drive.

Table Of Cantents 1 x + Catalog 1 x

%8 8| E v oty B E-| e |

= = Layers Location: [E tl_2016_25_tract.shp -
= tl_2016_25_tract El=IT) T

B3 AddivData
£ AleciatcGregor
5 Basic_Mapping_Practice
3 Census Exercise Materials
3 Census_Geography
5 Census_Practice
£ 3 Census2010

3 Aff Data

B 3 Census_Geograph
X] _AUTo_d5 tract.shp.eaisoxml

t1_2016_25_tract.shp.isasxml
@] Asians_Mass.mxd

£ Clip Tutorial

mEE e

m

3. Inthe Table of Contents, rename t|_2016_25 tract to Census Tracts. The census naming system for this
particular files works as such: tl =tiger, 2016 is the year the data represents, 25 is the state number —aka
Mass, and Tract is the unit of the administrative boundary.

4. Open the Census Tracts polygon attribute table and take a look at it. Which column matches the excel
document EXACTLY? The GeolD in the attribute table matches the GeolD2 from the excel table exactly!
Therefore, the GeolD column is what we will be using for joining our AFF data.

woaoaLay @ g

salnead ajeaio B [sainoumny [
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5. Right-click on GEOID field name and choose Properties. You’ll see it is a string type attribute field — that’s
important to know. Strings are the same as “text”, which is why we bothered to change GeolD2 to “text” in
excel! Close the table.

Field Properties =]
Census Tracts Name: GEOID
FID | Shape | STATEFP10 | COUNTYFP10 | TRACTCE10 | GEOIP4n L wancanl — —uamaciennen Al G0
0| Polygon |25 025 010405 2502501 = Sort Ascending —
1 | Polygon |25 125 010404 250250{ = Sort Descending
2 [ Polygon |25 025 010801 250250 ) Display
3| Polygon | 25 025 s10702 250250 dhanced Sormingz: [ Turn field off
4 | Polygon | 25 025 010204 250250 Summarize... [7]Make fieid read only
5 | Polygon | 25 125 110802 2502750 [ Highlight field
& | Polygon | 25 125 110104 250250
7 | Polygon |25 025 000703 250250 Field Calculator... ot
— -
g | Polygen |25 025 000504 250250 Calculate Geometry..
9 | Polygon | 25 025 000704 250250 [Lengin [
10 | Polygon |25 025 010103 250250 Turn Field Off
11| Polygon | 25 125 000803 250250 ]
F Unfreeze Col —
12 | Polygon |25 [ 360300 2502504 reeze/nireeze Lolumn
13 [ Polygon |25 125 120201 250251] % Delete Field
14 [ Polygon |25 025 120104 250251 F—
o — | — == — P = [ Properties... [— _cJK -w Apply
o4 0r m % (0 out of 204 Selected)

6. In Catalog, add your American Factfinder table to the map by dragging it in- you need to drill down
tothe sheet level:

E EJ Census2010
= 3 &ff_Data
= 2010 Census H11 population by housing tenure.xlss:
b Hausing_Tenure$|

7. If you get the following error, it means that your version of ArcGIS and Excel are having connectivity issues.
A solution may be to save your Housing Tenure excel sheet as an Excel 97-2003 Workbook (*.xls) or CSV.

Connect @

Failed to connect to database.
An underlying database error occurred.
Class not registered

8. Inthe Table of Contents, open Housing_Tenure Table by right-clicking on it and choosing Open- very
similarly to how you would open an attribute table.

|

Table

R AL T
Housing_tenures

GeolD GeolD2 Geography
1400000US25025000201 | 25025000201 | Census Tract 2.04, Suffolk County, Massachus«
1400000US25025000202 | 25025000202 | Census Tract 2.02, Suffolk County, Massachus«
1400000US25025000301 | 25025000301 | Census Tract 3.01, Suffolk County, Massachus«
1400000U525025000302 | 25025000302 | Census Tract 3.02, Suffolk County, Massachus«
1400000US25025000401 | 25025000401 | Census Tract 4.01, Suffolk County, Massachus«
1400000US25025000402 | 25025000402 | Census Tract 4.02, Suffolk County, Massachus«
1400000U525025000502 | 25025000502 | Census Tract 5.02, Suffolk County, Massachus«

9. GEOID2 will be used to join this AFF data to the 2016 Census. Right click on GeolD2 to check its properties.
Ensure that it is also a STRING type and then close table when done.

If it says double, long or short, that means you did not convert the data to text in excel. You must reopen
the excel file and redo step 2 from the previous section.

10. Right click on your Census Tracts and choose Join & Relates, then select Join...

10
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11. Fill in the dialog box as follows — you are joining attributes from a table, using GEOID in your Census Tracts

12.

13.

layer and GEOid2 in your AFF table — click OK when done:
Join Data |E|

.

Join lets you append additional data to this layer's attribute table so you can,
for example, symbaolize the layer's features using this data.

What do you want to join to this layer?

[Join attributes from a table -

1. Choose the field in this layer that the join will be based on:

GECQID -
2, Choose the table to join to this layer, or load the table from disk:

E 'Housing TenurES'I ﬂ

Show the attribute tables of layers in this list

3. Choose the field in the table to base the join on:

-

Join Options
() Keep all records

All records in the target table are shown in the resulting table.
Unmatched records will contain null values for all fields being
appended into the target table from the join table.

|@ Keep only matching records |

If a record in the target table doesn't have a match in the join
table, that record is removed from the resulting target table,

[ Validate Join ]

About joining data [ oK ] [ Cancel ]

Note: By clicking “Keep only matching records”, only Suffolk County will remain visible in the shapefile
because we only downloaded census tabular data for this one county in MA. If we select “Keep all records”,
MA would remain whole, however, the attribute table would only have housing information for the census
tracts within Suffolk County. The rest of the census tracts would read “Null” in those joined fields.

Open Census Tracts attribute table to ensure that the join was made correctly. If so, you should see your
housing tenure AFF data when you scroll to the right in the table. Close table.

It is important to know that when you make a join it is not permanent until you EXPORT THE DATA. Until
you export, the join is only temporary. If you run any tools on this layer without exporting the data, it will
drop the joined data. Exporting the data saves this shapefile as a NEW shapefile, where the join is now
permanently part of the attribute table.

Export the data by right clicking on the census tracts, selecting Data and then Export Data.
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14.

15.

16.

17.

Tahle Of Contents B x
T U &8 3
| = Layers

= B HiCensus2010MCensus

B
] & Copy

o 5 HiCensus201] X Remowve
B Housing T B Open Attribute Table
Joins and Relates 3

‘ » Zoom To Layer

Wisible Scale Range 3
Use Symbol Levels

Selection 3
Label Features

Edit Features 3

‘s Conwert Features to Graphics..,

Corvert Symbology to Representation...

‘ Data 3
< Sawe A3 LayerFile.., <w ExportData. I
-~ g
W’ Create Layer Package.. Export To CAD...
b 4 2 P Export Data
[ Propetties..

L Sawe this layer's data as a shapefile
I:j Wiew [tern Descriptic oy gendatabase feature class

Save the shapefile with an appropriate name inside the Geography folder (include Census tracts so you know
the boundaries and include the location). It can be good to acknowledge exactly what has been joined,
especially if you will end up having multiple joined layers. Also make sure to save as a shapefile, otherwise
you will encounter an error.

Export Data &J
Export: [.ﬂ.ll features vl
e =
Use the same coordinate system as: Y . - . -
’ Lok in: [EI Census_Geography '] & W @ | | 5 | BB
() this layer's source data
] [&It_2016_25_tract.shp
(@) the data frame
the Feature dataset wou export the data inka
(only applies if vou export to a Feature dataset in a geodatabase)
Oubput Feature class:
H:\Censuz211 M Cenzus_Geographwt Suffolk_CenzusTracts_Housing
Mame: Suffolk_CensusTracts_HousingTenure, shp
Save as bype: [Shapefi\e -] [ Cancel ]
File: and Personal Geodatabase Feature dasses
[ oK ] ’ Cancel ] Database feature classes

-

Exporting data is always good practice to ensure something is permanent. It also sometimes resolves minor
ArcGIS glitches, such as layers not drawing on the map.

Now before hitting OK you will need to decide if you want to save this new shapefile to the coordinate
system it came with (2016 Census Data uses GCS_North_American_1983), or if you have already put the data
frame into a certain projection you could select data frame (this map ultimately uses
NAD_1983_StatePlane_Massachusetts_Mainland_FIPS_2001). By setting your data frame projection first,
this then saves you the step of projecting your data later!

Press ok and then click yes when asked if you want to add the exported the data to the map as a layer. Now,
you should see a new layer in the Table of Contents with your given name. It has also been added to the
Catalog!
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Tahle Of Contents

T U 8

| = Layers

= EJ HACensus201Census_Geography

=] Census Tracts

O

= B HACensus20108AFF Datat2010 Censu:
B Housing_Tenure$

] LAl L1 I s i_aiihiow

= EJ Census_Geagraphy
(B Suffolk_CensusTracts_HousingTenure.shp
(B 11_2016_25_tract.shp
H_2016_25_tract.shp.ea.isomml
t_2016_25_tract.shp.isosml

18. Since you have saved this join as new shapefile, you can remove the join from the original Census Tracts
Shapefile. Right click on Census Tracts, and click Joins and Relates and then Remove Join(s) >
Housing_Tensure$.

Table Of Contents

%[00 8

| = Layers

= B3 HACensus2010Census_Geagraphy
= Suffolk_CensusTracts_HousingTer

L

N

=
o = CEERN
Copy
o El
= E3 HA\Census2 &Y Rernove
E Housing_|[E  Open Attribute Table

| Jnins and Relates lain.,
'__;’ Zoom To Layer Remove Jain(s) 4 H Housing Tenure$ ‘

Wisible Scale Range
Use Symbol Levels
Selection

Label Features

Edit Features

Convert Features to Graphics.,

Convert Syrmbology to Representation...
Data

Save A5 Layer File.,

Create Layer Package..,

Properties...

Relatz... Remave &ll loins L3

Remove Relateds) 3

19. When you do this, it removes the excel data and the shapefile reverts back to all of Massachusetts. The

reason why you would want to remove the join is so you can join a new or different tabular dataset to this

shapefile without having to download it again from the census!

20. After you remove the join from the original Census Tracts layer, turn the layer off. You are done working with

this one.

13



Tufts Data Lab

Removing Water Only Census Tracts
One tip —if your area of interest is near water or has water features in it (like Boston), yourtract data will extend
into the water. Why? Because people live on islands and on boats, and census tracts includes those areas!
However, we don’t always want to map them, so let’s remove them.

1. To get rid of the water tracts from your new shapefile, Suffolk_CensusTracts_HousingTenure, go the layer’s
Symbology tab in properties.

2. Click on Quantities and choose the variable D001 (or Tot_Pop if you renamed it in excel first).
3. Then click on Classify.

4. Inthe Classify dialog box, click on Exclusion. You can exclude all census tracts wherethe land area is equal to0
(no land — aka only water), and hit OK. These steps are outlined below:

Layer Properties =

Generall 50urce| Selectlonl D|sp|a_u| Symbology | Fields I Definition GuerylLabeIsI Jolns&Helatesl Time I HThL Pnpupl

Shiow:
Features w quantities using color to show val
Categories aification 4
Quantities = Dom - Matural Breaks [Jenks)
i Graduated colars E
Graduated symboks Mormalization:  none - Claszes: § = Clazzify.
Proportional spmbols
i Dot density Color R amp: . - -
é Charts
Multiple Attributes Symbol | Range Label
I 0. 000000 - 1181.000000 0.000000 - 1181.000000
1151.0000071 - 2841.000000 1181.000001 - 2841.000000
Classification ZL' Data Exclusion Properties ‘ @
Classification Classification Statistics m
Method: [Natura\ Breaks (Jenks) v] Court: EA ¥ llegen
Classes: 5 - iR 0,00001 Exclude clause:
e Maxdmunn: 8917.0000( = "HAMELSAD" ~l”
RalabReion Sum: £74795,00001 TR
Exclusion ... Sampling ... Mean: 3307.8186; YEUNCETAT" N
Median: 3166,50000 T Al AND
4| . L ", n
S HWATER -
Columns: o0 = [T Show Skd. Dev. [] show Maan
§ § § § § EBreak Yalues Fa
15— =] =] =] =] =]
g g g g 2 1151,000000
g Z B 2 = 2841.000000
- o = - = 4167,000000
5998, 000000
10+ 8917.000000
Get Unigue Yalues | Go To:
SELECT * FROM Suffolk_CenzusTracts_HousingT enure WHERE:
T “ELAND =0 i
0 T T T oK
0.000000 2778350000 4458 600000 687750000  #917.00000K - [ Gear [ verly |[ Help ][ Lood. |
Snap breaks to data values 1

5. Now you can make a map of your data in symbology which will no longer include census tracts that are only
water. If you are unfamiliar with mapping numeric values using symbology, see the ArcGIS 10.2 online help —
About Symbolizing Layers to Represent Quantity.

6. Now is a good time to save, with all your data ready to be mapped.

Here is an example of a map showing the percent of people in rental housing units for each tract in Suffolk County
(population renting normalized by total population in housing units). The map is using the “Dark Gray Canvas”

14
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option from ESRI’s basemap choices (Click on File > Add Data > Add Basemap to get this option). If you add the
basemap, turn off the Reference Layer (aka labels) because they don’t look great.

Table Of Contents B x
%[0]¢ 8| &
1 &
= £ HACensus2010\Census_Geography
=] Suffolk_CensusTracts_HousingTel
D004/ D001
[111-39%
[ 40 - 56%
57 - 70%
W 71-84%
85 - 100%
= O Census Tracts
O
= £ HACensus2010MAFf_Datal2010 Censu|
E Housing_Tenure$
=] World Dark Gray Reference
[ Dark Gray Canvas Reference
] World Dark Gray Canvas Base

=X

[1seuyioman I |

Note: Do not just accept the default colors. Play around with the different color schemes!
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Setting a Projected Coordinate System for your Map
It is good cartographic practice to put your map into a projected coordinate system. The TIGER data is in a geographic
coordinate system (GCS) and can appear stretched in an odd way on your map. You can fix this problem by setting a
projected coordinate system appropriate for yourregion.

You will need to know the best coordinate system to use for your area. In the case of Massachusetts, we will use the
Massachusetts State Plane (NAD83) — meters coordinate system. If you don’t know what coordinate system to use,
use this resource. It is a quick read that gives you an understanding of what needs to go into selecting a projection,
and at the end provides a table.

1.
2.

5.

Click on View - Data Frame Properties.
Click on the Coordinate System tab.

Scroll down till you find the Projected Coordinate Systems folder. Make sure you are not still in the
“Geographic Coordinate System” folder.

Scroll down to the State Plane folder — open that folder and select NAD 1983 (Meters) from the list:

P

Data Frame Properties |

Annactation Groups I Extert Indicators | Frame | Size and Position | Product Library
General | Data Frame | Coordinate System | llumination | Grids I Feature Cache

-' v| Type here to search v @ | Qﬁ v 5t

= 5 State Plane -
£ NAD 1927 (US Feet)
£ NAD 1983 (CORS96) (Intl Feet)
£ MAD 1983 (CORS96) (Meters)
£ NAD 1983 (CORS96) (US Feet)
£ NAD 1983 (Intl Feet)
E3 NAD 1983 (Meters)
£ MAD 1983 (US Feet)
£ MAD 1983 HARN (Intl Feet)

P MAM 106 LIADRI A fnbnesl

Find NAD_1983_StatePlane_Massachuestts Mainland (not Isl which means Islands) and click on it:

Data Frame Properties | 28

Arggpotation Groups | Extent Indicatars | Frame I Size and Position I Product Librany
| | Diata Frame | Coordinate System | llumination | Grids | Feature Cache

Type here to search - @ | C‘f - %

@ MAD 1983 StatePlane Maine West FIPS 1802 (Meters) -
@ NAD 1983 StatePlane Maryland FIP5 1900 (Meters)

@ MAD 1983 StatePlane Massachusetts FIPS 2001 (Meters)
@ NAD 1983 StatePlane Massachusetts Isl FIPS 2002 (Mete
@ NAD 1983 StatePlane Michigan Central FIPS 2112 (Mete
@ NAD 1983 StatePlane Michigan Morth FIPS 2111 (Meters
@ NAD 1983 StatePlane Michigan South FIPS 2113 (Meters
@ NAD 1983 StatePlane Minnesota Central FIPS 2202 (Met

. A MANANGI Tt allmme M 4o Blmwkls CTOC I (R A
4 m k

Current coordinate system:

MAD_1933_5tateFlane_Massachusetts_Mainland_FIPS_2001 -
WKID: 26586 Authority: EPSG

6. Click OK and click Yes when warned that the coordinate system is different from the data inyour maps.

You’re done! You have successfully downloaded American Fact Finder data (AFF) and joined it to Census Geography
data in ArcMap. This routine of data search and prep might sometimes take longer than creating the map, but doing
it correctly is important to assure that conclusions drawn from its map(s) are sound.
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